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The Maestro Access Control and Security system 

The Maestro system is a complete Microsoft Windows based family of software 
for managing systems as small as a hand full of secured doors, all the way up to 
enterprise scale multi-premise systems consisting of thousands of secured 
access and alarm points. Available in both single user and multi-user network 
versions, the modular design allows the end user to ease the learning curve by 
learning just the components required to implement their system.  

System flexibility is a must in todayís interconnected world. Maestro addresses 
these needs in two ways. On a lower level implementation world, the embedded 
macro command language permits the design of custom logic when Maestro's 
standard event handling mechanism is insufficient. This macro language 
includes all the standard flow control language constructs one would expect 
from a high level programming language including the ability to test device state 
information in Boolean conditions. 

When integration or system extensibility is required, the Sage API provides a 
rich and complete set of functions for programmatically controlling all aspects of 
the Maestro system. Using the Sage API, software can be developed to address 
the ìspecialî requirements, which are encountered in many large scale jobs 
without the traditional down-sides associated with ìcustomî software. Sage 
provides a cost effective, supportable means of capitalizing on these special 
requirements by developing external software applications which interact with 
the Maestro system through the Maestro server engine. This interface acts as a 
bidirectional gateway to the Maestro system and provides the external 
application with full access to all core Maestro functionality. 
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 The Maestro Access Control Software family 

 

 
Maestro software is available to support 
systems from a basic two door configuration to 
an enterprise scale system with thousands of 
card readers and alarm points operating in a 
LAN environment with multiple operator 
workstations.  

Maestro software integrates three primary 
building management functions into one easy to 
use software package;  

 

 

1. Door Access Control ...control and monitoring of up to 512 entry/exit card 
readers and 65,000 card holders.  

2. I/O Point Control ....monitoring and control of up to 4,096 alarm inputs and/or 
output control points for automated security functions.  

3. Elevator Access Control  ....control and monitoring of access to elevators. 

The Maestro family of software is based upon the standard Plus or Net platforms 
but can be extended via the following additional packages below. Not all of 
these options are available for the Plus standalone version. 
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Maestro Plus  
Standalone Access Control system supporting from 8 
to 512 readers and up to 4096 IO points. Elevator 
access control available in configurations supporting 
16, 32, 48, and 64 floors. 

 

 

 

 

 

Maestro Net 
Network based Access Control system supporting from 
8 to 512 readers and up to 4096 IO points. Elevator 
access control available in configurations supporting 
16, 32, 48, and 64 floors. Up to 20 network clients are 
supported in a LAN environment. 

 

 

 

 

 
Maestro Tour  
Integrated Guard Watch Tour package.  
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Maestro Badge 
Integrated Photo ID card production and data entry 
package. 

 

 

 

 

 

 
Maestro Photoview 
Photo ID based monitoring package. 

 

 

 

 

 

 

Maestro Page 
Remote Pager and email annunciation package 
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Maestro Terminal Server 
Remote system management by as many as 20 
remote clients using WAN and/or POTS dial up 
connections.  

 

 

 

 

Maestro Remote Alarm Client 
Multi site remote alarm annunciation using POTS dial 
up, and WAN connections. 

 

 

 

 

 

Maestro Map 
Graphic map package supporting both vector and 
raster based graphics, 5 levels of zoom and map 
linking. 
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Maestro Partition 
Multi-Tenant partitioning package for creating multiple 
virtual Maestro systems. 

 

 

 

 

 

Maestro Temp Access 
Temporary card access for staff and/or visitors. 
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 Overview - Setting up the Software 

Maestro embodies are large set of customizable features to allow it to be 
tailored to your specific requirements. This section reviews the mandatory and 
optional features which should be reviewed when configuring a Maestro system. 
The topics covered include; 

Communication Ports 
Network Trunk Lines 
System Properties 
Panels 
Shared Input and Output Points 
Readers 
Elevator Floor Sets 
Schedules 
Holidays 
Auto Void\Validate 
Scheduled Events 
CCTV Camera and Monitor Definitions 
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Setting up Communication Ports 

Trunk serial communications ports are set up under the menu item; 

Edit->System->Communication Ports  

 

Maestro supports up to 16 
serial based trunk lines through 
the use of optional multi-port 
serial cards, on board serial 
ports and the CLA-USB RS485 
adapter. 

Each COM port can be 
configured independently for 
either Daisy Chain or Multi-
Drop communications (see the 
CP30/40 Installation Manual for 
details).  
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Network Trunk Lines 

In addition to the 16 supported serial trunk lines, it is possible to define virtual 
trunk lines using the Canlan Ethernet to RS485 controller. The Canlan controller 
acts as a TCP/IP interface module for 1 to 16 CP30/40 access control panels. 
Each Canlan must be configured with an IP address and port number (see the 
Canlan Installation and configuration guide for more details). Once configured 
and operational, panels may be defined referencing trunk addresses from 17 to 
255.  

 

Network trunk definitions 
are set up under Edit-
>System->Network Trunk 
Addresses menu item. 
Select a trunk address by 
highlighting the trunk 
number. Each trunk may 
be given a descriptive 
name which will be 
referenced throughout 
the Maestro software. 
Enter a name, the 
corresponding IP 
address and port number 
and either select OK or 
choose another trunk line 
to edit. 
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System Properties 

The System Properties dialog contains start up and operational settings for the 
Maestro software. System Properties are accessed from the Edit->System-
>Properties menu item. The properties are organized into 8 separate tabs (7 for 
the standalone version). 
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Start Up 

The Start Up tab contains items related to how the Maestro software first starts 
up. 

 

The follows items can be configured to establish the way Maestro starts; 

 

Configuration 

System Name 
This is the name which is displayed in the title bar and is used as the 
basis of data files created which are specific to this system (network 
version only). 
 
Date Format 
Choose from one of the three available date representations used by the 
software; 
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! Day, Month, Year 
! Month, Day, Year 
! Year, Month, Day 

 
Restore Window Positions 
This option saves the placement of the main window and the child 
transaction, device and map windows such that they are restored to the 
same positions when the software is re-started. 
 
Operator Login Required 
This option determines whether or not an operator must login before 
accessing the software.  
 
Single Instance of Maestro 
This option permits only a single copy of the Maestro software to be 
executed on the specified computer. 
 
Auto-Start GAPB 
This option automatically enables Global Anti-Passback when Maestro or 
the Maestro server software is first started. 

 
 

Toolbars 

Command Tool Bar 
Defines the startup state of the Command tool bar (ON /OFF). 
 
Edit Tool Bar 
Defines the startup state of the Edit tool bar (ON /OFF)  
 
Association Tool Bar 
Defines the startup state of the Association tool bar (ON /OFF) 
 
CCTV Bar 
Defines the startup state of the CCTV tool bar (ON/OFF) 
 
Status Bar 
Defines the startup state of the Status bar (ON /OFF)  
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Alarm Queue 

Alarm Wav File 
This is the wave file which will be played while alarms are present in the 
Alarm Queue. This feature requires a sound card.  
 
Enable Alarm Queue 
Determines the state of the Alarm Queue at startup. Can be overridden 
from the File menu.  
 
Enable Alarm Horn 
Determines the state of the Alarm Horn at startup. Can be overridden 
from the File menu. 
 
Pop-Up Alarm Queue 
Determines whether or not the alarm queue will pop up on top of all 
existing windows when a new alarm is placed in the queue. 
 
Group Acknowledgements 
This option if checked permits multiple alarms to be selected and 
acknowledged in a single operation. 
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Pin Algorithm 

 

This tab selects the 
keypad PIN algorithm 
that will be used by all 
keypad readers. The 
value selected 
determines the PIN 
(Personal Identification 
Number) that must be 
entered by each user. 
Up to 10 algorithms 
are available for 
generating PIN 
numbers.  
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Server 

The Server tab is only visible in the network version of Maestro. The entry 
specified here identifies the computer running the Maestro server software. 

 

The data entered here 
is typically the machine 
name of the server 
computer. This can be 
found by right clicking 
the My Computer icon 
and selecting 
Properties from the 
pop up menu. The 
Computer Name tab 
specifies the system 
name in the Full 
Computer Name field 
entry. 

Alternatively, the IP 
address of the system 
can often be entering 
on computers running 
on an IP network. In 
either case, the 
Maestro software must 
be re-started before 
these changes will 
take effect. 
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Network 

The Network tab determines how Canlan connectivity issues are to be displayed 
and recorded in the history files. Three options are available; 

! Report both panel and Canlan events 
! Report Canlan events only 
! Report panel events only 

 

Panel events is 
provided for backward 
compatibility with 
previous versions of 
Maestro. This option 
reports Canlan 
connectivity failures by 
issuing a No 
Communications 
message for each 
panel on the 
associated trunk line. 
The Report Canlan 
events only option 
records these issues 
via the Network 
Connection 
Lost/Restored 
message and is the 
current default. The 
last event is a 
combination of the two 
methods and the most 
verbose 
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Display 

 

The Display tab 
provides the ability to 
select the type of 
events to display in the 
transaction window, 
while filtering others 
out. In addition, the 
color associated with a 
specific class of event 
can be chosen along 
with the window 
background color to 
call attention to 
specific event as they 
occur in real time. 
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Print 

The Print tab provides the ability to select the type of events to be output to a 
tractor style dot matrix printer, while filtering others out. Note that typically laser 
printer will not output a page until a complete page buffer has been received. 
For this reason, only tractor feed type printers are useful in this application. 

Like the Display tab, 
the desired event types 
may be chosen by 
checking the 
associated event. The 
Printer port entry 
specifies the LPT port 
number of the desired 
output printer. 
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Fields 

The Fields tab allows the enforcement of mandatory data fields in card holder 
records. 

 

Entries that are 
checked indicate card 
holder fields where 
data must be entered. 
The last option 
Automatic conversion 
to uppercase re-maps 
all alphabetic 
characters to their 
uppercase equivalent 
upon saving. 
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Audit Setup 

Allows you to configure 
how Audit Trail Files 
are managed. Audit 
data is written to a 
ìcurrentî Audit Trail 
File as transactions 
occur. When a 
specified file size has 
been reached or a 
specified interval has 
elapsed (a day, week 
or month), the system 
closes the ìcurrentî 
Audit Trail File, 
archives it and creates 
a new ìcurrentî file. 
You are able to specify 
the number of archived 
files to retain.  
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Panels  

One of the first steps when setting up Maestro for the first time is the definition of 
control panels. This is done from the Edit->Panels menu.  

 

 

 

The following data must be defined for each panel;  

! The Trunk Line to which the panel is connected  
! The address of the panel (1-16) as set on the panelís address switches  
! The type of expansion board used (None, 16 point I/O, or 16\64 floor 

elevator board) 
! The user defined logical reader numbers (1-32\64\128\256\512) for the 

two associated readers  
! The user-defined reader name (maximum 30 characters)  

If the panel is equipped with a 16 point I/O board, the following additional 
information must be defined for each of the 16 points;  

 


